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Task 

In this exercise you will learn how to modify a folding box from the library of resizable standards. 
You will do this by removing all closing elements on the top of the box and replacing them with a 
new type of closing system, and as a second step, you will complete the structure with new locking 
system. Both compound components you will take out from the Synergy Components library. 
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Exercise box: A.50.45.01.01 Claw-Lock Closure Systems - Winged Flap Closure with 
Dustproof Flaps.evr. 

Location: 

 

 

 

Components 
(Location, Name) 

EngViewWork6\Standards Library \MM\ 

Standards\Folding Carton\ECMA \Long Seam Rectangular\ 

A.50.45.01.01 Claw-Lock Closure Systems - Winged Flap Closure with Dustproof 
Flaps.evr. 

1.Compound Components/Tops and Bottoms/Regular Tucks/ 01 Regular Tuck Lock 

2.Compound Components/Parts/Tongue Locking Systems/ 30 Tuck Tongue (Centered) 

  

Library standard A60.45.00.01: Modified project: 

A (Length) = 90 mm  A (Length) = 140 mm 
B (Width) = 60 mm  B (Width) = 75 mm 
H (Height) = 150 mm H (Height) = 130 mm 
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 2D structure of A.50.45.01.01 
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2D structure of the modified design 
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Opening and Resizing the Standard A.50.45.01.01 

From the Packaging Library Index 

1. To open the index, click your system's Start button, in Programs, locate the EngView Systems 
group, and then click Packaging Library Index.  

 The index opens. 

 

2. Click the Index tab, type the design's ID: A.50.45.01.01, and then click ENTER. 
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The design appears in the right-hand window. 
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3. To open the design in Package & Display Designer, click the blue icon . 

Package & Display Designer starts, opening the design in its 3D view. 

From Package & Display Designer 

1. Start the program. 

2. To begin opening the design, do any of the following: 

• On the File menu, click New. 

• In the toolbar, click the New Project . 

 

The Material dialog box appears. 
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3. Click From Resizable Design. 

4. In Base type, select Folding Carton Cardboard, and then, in Name, select the material that you 
want to work with. 

5. To proceed, click Next. 
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6. To start searching for the design, in Look in, browse the sequence: Folding Carton | ECMA | A – 
Long Seam Rectangular. 

A list of designs appears 
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7. To locate the design, in Search type the design's name: A50.45.01.01 Winged Flap Closure With 
Dustproof Flap. 

NOTE: Notice that the list of designs grows shorter with each new symbol you type. 

8. After you have typed the design's ID, select the design in the list. 

 NOTE: Notice that the design is visualized in the preview zone in the right-hand area. 

9. To open the design, click Finish. 

 The design opens in its 3D view. 

Preparing the Work Environment 

1. To switch to the 2D view, in the graphical area, click the 1p drawing tab (pictured). 
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2. After the file is opened, resize the structure: In the Parameters tab, in the Expression column 
modifying the expressions of the main parameters: Make A=140; B=75 and H=130. 

NOTE: For each value, press ENTER after typing the value. This confirms it. 
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Deleting Components 

A resizable design is composed of different parts (components). 

 

We begin modifying the resizable design by removing the top components and replacing them with new 
compound components from the Synergy Components library. 

1. Select the top of the design. 

Consider the objects that you want to select, and then press the selection buttons on the toolbar. The 
options are: 

 Select with Intersect Selects all the objects that fall within the rectangle, either entirely or 
partially. 

 Select Outside Objects Selects all objects that are entirely outside the rectangle. 

The two buttons can be used independently. This produces four selection scenarios: 

ENGVIEW PACKAGE & DISPLAY DESIGNER TUTORIAL — MODIFYING PARAMETERIC DESIGNS | PAGE 13 



  — Selects the objects that are inside the selection rectangle, either entirely or partially. 
Objects that are entirely outside the selection rectangle are not selected. 

 — Selects the objects that are entirely inside the selection rectangle. 

 — Selects the objects that are entirely outside the selection rectangle. Objects that are inside 
the rectangle, either entirely or partially, are not selected.  

 — Selects the objects that are outside the selection rectangle, either entirely or partially. 
Objects that are entirely inside the rectangle are not selected. 

If we choose the first mode and select this way: 

 

we could miss some tiny elements: 
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That is why when an entire top or bottom are to be deleted, it's best if we use the second mode. 

 

2. To delete the selection, do any of the following: 
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• In the graphical area, right-click a blank area, and then click Delete on the context menu. 

• On the Edit menu, click Delete. 

• Press CTRL + DELETE. 

After the deletion, the drawing should look like this: 
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Attaching Synergy Components to the Design's Structure 

The Synergy Components library is a collection of ready-to-use parametric components used in 
assembling a 2D structural design. 

1. Click the Synergy Components dropdown menu, and then click the Synergy Components folder. 

The subfolder structure appears. 

 

The library consists of three major groups of components: 
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Bases A base component is the foundation on 
which other components are attached to make up 
a resizable design. Each resizable design can 
have only one base, to which you attach single or 
compound components or whole parts of boxes. 

Compound Components A compound 
component is made up of one or several 
individual (single) components. It represents a 
ready part of a design — for example, top, 
bottom, whole locks. It has two or more active 
control points on which it is attached during the 
assembly of a resizable design. 

Individual Components A single component 
is part of the design attached to the base to 
assemble a resizable design or to create a 
compound component. The single component 
has two active control points. 

 

In our case we will attach a new top by using a compound component. There are two techniques of 
doing this: 

Modifying without further parameter control The new components will be well calculated according 
to the current length and width of the box, but when new values are entered for length or width, the 
newly attached components will not recalculate. This technique is mostly used when we need to edit 
the drawing only once – that is, when we know that no further changes for width and length will be 
made in the drawing. 

Modifying with further parameter control (Advanced Parameter Matching) The new structure will 
be well calculated according to the length and the width of the box, and when new values are entered 
for the length and the width, we will always have a well-recomputed design. This is used when we will 
make further changes to the design's sizes after the new top has been attached. 

We will do the composition of the structure by exploring the two techniques. 

Modifying without parameter-controlled resizing 

1. On the Tools menu, click Options, and then click the Synergy tab. 

2. In the Show area, ensure that the Advanced parameter matching check box is not selected. 
3. Click the Synergy Components dropdown menu, and then click the Synergy Components folder. 
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The Synergy Components folder tree appears. 
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4. Browse the sequence Compound Components | 01 Tops and Bottoms | 01 Regular Tucks. 

A list preview of the available components appears in the right-hand area. 
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NOTE: The preview area consists of two zones: a list zone, which contains the components in the 
current group, and a preview zone, which offers a view in detail of the currently selected component.  
Both the entire list view area and the preview zone can be expanded and reduced as needed 
(pictured). 
 
NOTE: You can change the size of the component icons – on the Tools menu, click Options, and then 
click Synergy. Then, in Image Width and Image Height, enter values that suit you. 

5. In the preview area, select the component 01 Regular Tuck Lock, and then begin dragging it into 
the graphical area. 
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NOTE: When you drag a component to the graphical area, four modes become available:   

 – Horizontal mirror (flips the component along the y-axis) 

 – Vertical mirror (flips the component along the x-axis) 

 – Shows the dimensions set for the component 
 

 – For a selected component, opens the component's parameters table. 
 
Sometimes, however, we need to mirror a component to be able to attach it correctly and create a valid 

design. In this case we use the Horizontal Mirror    or the Vertical Mirror    buttons. 

6. Click Vertical Mirror    to mirror the component. 
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7. Start attaching the mirrored compound component to the base from right to left. Position the first 
active point of the component on the first point of the base (pictured). 
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8. Position the second active point on the first folding line and click to attach the point. Position the 
rest of the active points in the same way, finishing in the left base corner: 

 

After you have attached the last point of the component, the Component Parameters dialog appears. 
Note that the parameters #AX2 and #AX3 have adopted the values of the distances that form during 
the clicks we made. #AX2 adopts the distance between the second and the third clicks; #AX3 adopts 
the distance between the third and the fourth clicks. 

In fact, these distances are the length and the width of the box. Owing to this, the new top was resized 
according to the base, because formulas exist in the compound component that resize it while it is 
being attached. In our case this is a panel that has the distance #PH: 

 

Notice that the height of this panel — #PH — is computed in relation to the extracted distance #AX3, 
which is 75. 
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At this step we can edit the parameter values for all parts of the top. For example, the height of the dust 
flaps (#DFH). 

 

9. Click in the Expression field, and type 40. 

Note that the heights of the two flaps have changed. 

 

IMPORTANT: Dependencies between concrete parts or distances can be preset in compound 
components. In the current compound component such distances are Z и SLL. These parts or 
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distances take part in the top’s locking system, which is why a dependency has been preset between 
them. 

 

 

10. Let us now change the value of #Z: Make it 10.  

The slit’s length has updated. 

11. To confirm the values, click OK. 

The component is now attached to and resized according to the base. 
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IMPORTANT: If after the attachment we decide to change the box’s width — for example, B=90 — the 
top (panel 1 in the next picture) will not be recomputed. 
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Additionally, note that once the compound component has been attached to the base the compound 
component breaks down to individual components. 

 

After the component has been attached, it no longer consists of a single drawing but is broken down to the four 
individual components it was originally made up of. 

These components no longer have dependencies between them. This means that if we need to edit a 
distance after the compound component has been attached, other distances linked to that distance in 
the other individual components will not recalculate automatically and must be edited separately. 

For example, if we need to change the size of the top’s locking system, we need to edit three 
components: the two flaps and the tuck-end. 

We begin by changing the #Z distance. To do this, we need to open the Component Parameters table 
of the flaps. 

12. Double-click one of the flaps and make #Z=15, and then click OK. 

NOTE: To click a components, click any of the line that make it up. 
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Note that only one of the flaps has changed. 

13. Repeat Step 12 for the second flap. 

We already mentioned that parts of the flaps take part in the top’s locking system. That is, once we 
have changed them, we need also change the slit of the tuck-end. 

 

14. Double-click the tuck-end. 

15. In the table that appears, make #Z=15. 

As a result of the formula, the SLL parameter has changed. 
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Now we are going to edit the heights of the flaps. 

16. Double-click any of the flaps. 

17. Make #DFH=55, and then click OK. 

Note that only one of the flaps has changed. 

 

18. Repeat Steps 16 and 17 for the second flap. 

19. Save the changes to the file: On the File menu, click Save. 

NOTE: There are two ways for saving the file: 

• As EngView File Saves the file into a default location predefined in the user interface at 
Tools | Options | File Locations | Working Folders | EVD files. Alternatively, you can browse 
a location. 

• To Project Organizer Saves the file into the database of Project Organizer, the EngView 
data management program. This option is unavailable if this software is not part of your 
configuration. 
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Modifying with parameter-controlled resizing (Advanced Parameter Matching) 

1. Open the resizable design A.50.45.01.01 Claw-Lock Closure Systems – Winged Flap Closure with 
Dustproof Flaps.evr. 

2. Delete the design's top. 

3. In the Parameters tab, right-click, point to Groups, and then click Check All. 

 

4. After all the parameters are listed in the table, right-click, and then click Delete Unused. 
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The parameters that have no roles in the design have been deleted. 

5. Make A=140, B=75, and H=130. 

6. On the Tools menu, click Options, and then click the Synergy tab. In the Show area, select the 
Advanced parameter matching check box. 
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Turning on this functionality enables editing the resizable structure by changing the values of 
parameters after components have been attached. 

After a component — compound or individual — has been attached its parameters are moved to the 
project's list. 
The benefit here is that during attachment of compound components, the parameters of the compound 
component became dependable on those of the base. For example, if we change the width of the box, 
the top panel will recalculate automatically. Another benefit is that the dependencies between the parts 
of the compound component are preserved. 
7. Browse the sequence Compound Components | 01 Tops and Bottoms | 01 Regular Tucks, and 

then attach the component 02 Regular Tuck Lock. 

8. Before attaching the component, use the Vertical Mirror functionality  to mirror the component. 

After the last point of the component has been attached, the Component Parameters dialog opens 
automatically. The table represents the full list of component’s parameters. 
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As we are working in the Advanced Parameter Matching mode, there are check boxes in front of the 
names of the dimensions. What does this mean? Let us take a look at the ninth row, displaying #Z. We 
can see that the distance named #Z will be linked to the parameter Z (displayed in the Design Name 
column), which will appear in the parameters list with the expression 7. As a result, this distance will 
become editable by changing the expression of the parameter Z. 
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NOTE: As we have #Z distances in both flaps, the parameter Z will control both flaps at the same time. 

Let’s pay attention to the distances #AX2 and# AX3 on the top of the list.  

We already know that during attachment of the compound component, the program extracts the 
distances between the clicks and send this data to #AX2 and #AX3. Thanks to the Advanced 
Parameter Matching functionality, the program detects that parameters exist that have these values 
and links #AX2 and #AX3 automatically with these existing parameters (A and B here) in the 
Expression column. 

IMPORTANT: The local parameters #AX2 and AX3 link the structure that we attach to the base. That is 
why it is critical that the expressions of these parameters must contain the parameters that control the 
design's main sizes – in this case these are the parameters A and B. In this way the attached bottom 
will be recomputed when the expressions of A and B change. 

By default, the two parameters are not selected, because they have been substituted by the existing 
parameters A and B. 

Why are some rows with selected check boxes highlighted in yellow? 
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These rows are highlighted in yellow, because the parameters (in the Design Name column), which will 
be linked to the component's dimension lines, are new for the drawing; they are not listed in the 
parameters list. Highlighting the parameters means that the parameters named THE, DFH, DFC, Z and 
others will be added to the Parameters tab list. In this way, the corresponding distances will be 
editable through these parameters. 

Also, the parameters in the compound component will go to the drawing's parameters list together with 
the dependences between parameters predefined in the compound component. For example, the 
parameter SLL depends on the parameter Z. 

 

Why some rows with selected check boxes are not highlighted? 

The grey-highlighted rows mean that parameters that have these names already exist in the parameter 
list. This means that the expressions of these existing parameters will override the expressions of the 
parameters in the compound components. 

For example, the parameter PH=A/2 had existed in the drawing’s parameter list before we attached the 
new flap. (The parameter controls the flap's height in the box's bottom.) 

ENGVIEW PACKAGE & DISPLAY DESIGNER TUTORIAL — MODIFYING PARAMETERIC DESIGNS | PAGE 36 



 

But in the new compound component the parameter PH is linked to the height of the panel, and it 
needs to be AX3-1.5. If we leave things as they are, we would have one parameter that controls two 
different panels that have different functions. This must not be. That is why we will create a new 
parameter that will control the panel's height in the new top. 

9. Clear the check box in front of the #PH distance. 

The Design Name field is now empty and the formula preset for the compound component has 
appeared in the Expression field. 
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10. Click the Expression field, and then type PH1 in it. 

Note that no dialog box appeared for creating a new parameter. This means that a parameter named 
PH1 already exists. This means that we need to create a new parameter. 

11. To obtain the formula set originally in the compound component, select the check box in front of the 
#PH, and then clear it. Then in the Expression field type PH2. 

A dialog box appears for creating a new parameter. Note that in Expression, we see the formula 
originally set for the component. Which is what we need to have. 
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12. Click OK. 

We now have a parameter that controls the panel’s height in the new top. 
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Let us pay attention to the other two parameters, UL and LSC, which are selected but not highlighted in 
yellow. 

The parameter UL, when set to Yes, removes the crease line of the top panel relative to the crease line 
of the dust flaps; when set to No, it makes the two crease lines collinear.  

The parameter LSC sets the distance by which the crease line of the top panel is to be removed when 
UL is set to Yes. 

These two parameters are already in the parameter table because the bottom follows the same logic. 
As the parameters in the compound component in the top play the same role as those in the bottom, 
we can use the same parameters for both parts of the box – the bottom and the top. That is why we will 
not create any new parameters to control the top separately. 

13. Click OK. 

The rest of the parameters that were highlighted in yellow have now gone into the parameter list. In this 
way we are now able to edit the top through the parameters in the parameter list. Moreover, we can 
use the same parameters to edit both flaps. For example, changing the height of the two flaps is done 
by changing the value of the parameter DFH. 

14. To see the newly added parameters, click the Parameters tab. 

We will use the Trace Object Selection functionality, which highlights the parameters linked to a 
distance or a component that we point to in the graphical area. 

15. To turn on the functionality, in the tabular area, right-click and then check Trace object selection 
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16. To quickly find the parameters linked to the new top, select its components. 
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17. Make Z=15. 

Both flaps have been modified, and the slit (parameter SLL) was recalculated automatically. 

Attaching a Tongue Locking System 

In addition to the top closing system, we can add locking elements. 

1. Browse the sequence: Synergy Components Tab | Synergy Components | Compound Components 
| Parts | Tongue Locking Systems. 

2. Select the 30 Tuck Tongue (Centered) component, and then drag it into the graphical area. 

3. Mirror the component vertically in order to prepare it for correct snapping towards the basic 
structure. 
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4. Start attaching the active points of the components from right to left on the base structure 
(pictured). We need to pay attention to which control points the new components are attached so 
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that they are correctly centered on the structure. 

 

After the last active point is attached, the Component Parameters dialog opens.  
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The highlighted rows indicate that all the parameters in the component are new for the project and will 
be included in the project’s parameter list after OK is clicked. 

5. Click OK. 

 

NOTE: The new parameters came with the expressions set in the compound component. That is why 
the dependency between the tongue width (TTW) and that of the slit (CL) was transferred also in the 
project’s parameter list. 

6. Save the file. 
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